Xerox® FreeFlow® VI Suite
What's New in Version 16.0.3.3
Reference Guide
# Table of Contents

1 Introduction .......................................................................................................................... 5  
   Important License Information ............................................................................................ 6  
   Platform Support ................................................................................................................ 7  
   VM Environments Support ................................................................................................. 8  
   Adobe Acrobat and Acrobat Reader ...................................................................................... 9  
   Purpose and Use of this Document ..................................................................................... 10  
   Upgrade Recommendation ................................................................................................. 11  
   Xerox Specialty Inks ............................................................................................................ 12  

2 Xerox® VIPP® Manage 16.0.3.0 ............................................................................................. 13  
   New Features in Xerox® VIPP® Manage ........................................................................... 14  

3 Xerox® FreeFlow® VI Design Express 16.0.3.3 ................................................................. 15  
   New Features in Xerox® FreeFlow® VI Design Express ..................................................... 16  
   Configuring Xerox® FreeFlow® VI Design Express to Submit Jobs to Xerox® FreeFlow®  
   Core ................................................................................................................................... 17  
   Submitting a job from Xerox® FreeFlow® VI Design Express to Xerox® FreeFlow® Core  
   from Adobe InDesign ....................................................................................................... 17  
   Configuring Xerox® FreeFlow® VI Design Express to Submit Jobs to Xerox® FreeFlow® VI  
   eCompose .......................................................................................................................... 18  
   Submitting a job from Xerox® FreeFlow® VI Design Express to Xerox® FreeFlow® VI  
   eCompose from Adobe InDesign ....................................................................................... 18  

4 Xerox® FreeFlow® VI eCompose 16.0.3.1 ............................................................................ 19  
   Platform Support ................................................................................................................ 20  
   New Features in Xerox® FreeFlow® VI eCompose ............................................................. 21  

5 Resolved Issues ................................................................................................................... 23  

6 Known Issues and Limitations ............................................................................................. 25  
   Xerox® FreeFlow® VI Design Express ............................................................................... 26  
      Installing Xerox® FreeFlow® VI Design Express on Mac ............................................. 26  
      Uninstalling Xerox® FreeFlow® VI Design Express on Mac ....................................... 26  
      Compatibility with macOS Version 11 .......................................................................... 27  
      Specifying Media and Finishing Options for a Job Sent to a Printer ............................. 27  
      Prefixed CSV File Does Not Load Properly for macOS Only ....................................... 27  
   Xerox® FreeFlow® VI Design Pro ..................................................................................... 28  
      Uninstalling Xerox® FreeFlow® VI Design Pro ............................................................ 28  

Xerox® FreeFlow® VI Suite  
What’s New in Version 16.0.3.3 Reference Guide  
3
# Table of Contents

**Xerox® FreeFlow® VI Explorer** ................................................................. 29

**Uninstalling Xerox® FreeFlow® VI Explorer** ........................................... 29

**Xerox® FreeFlow® VI eCompose** .............................................................. 30

**Enabling FreeFlow VI eCompose Web Application** .................................... 30

**Enabling Optional Features after the Initial Installation** .......................... 30

**Important Cluster Configuration Information** ........................................... 30

**Initializing Xerox® FreeFlow® VI eCompose for the First Time** .................. 30

**Upgrading from a Previous Version** ......................................................... 31

**Password Change Utility after an Upgrade to 16.0.3.1** ............................. 31

**Help System for the Xerox® FreeFlow® VI eCompose Web Interface** ........... 31

**Xerox® FreeFlow® VI Compose** ............................................................. 32

7 Important Information About PDF ................................................................. 33

**Adobe PDF Print Engine (APPE)** ............................................................ 34

**PDF Using VI Suite Tool Set** ....................................................................... 35

**Adobe Acrobat and Adobe Reader Information** ......................................... 35

**Configuring Adobe Acrobat and Adobe Reader Privileged Folder Settings** .... 35

8 FreeFlow VI Suite Printer Support ................................................................. 39

**Printer Support** ......................................................................................... 40
Introduction

This chapter contains:

- Important License Information ................................................................. 6
- Platform Support ......................................................................................... 7
- VM Environments Support ........................................................................ 8
- Adobe Acrobat and Acrobat Reader .............................................................. 9
- Purpose and Use of this Document .............................................................. 10
- Upgrade Recommendation ......................................................................... 11
- Xerox Specialty Inks ................................................................................... 12

The FreeFlow VI Suite 16.0.3.3 release is an update to FreeFlow VI Suite 16.0.3.1. The term VI Suite refers to one or more of the available FreeFlow VI Suite products.

Before you begin:

- Stop all FreeFlow VI Suite programs that are running currently.
- Close and exit all FreeFlow VI Suite programs that are running currently.

For example, if you are installing VI eCompose, before you begin installing a newer version of the product, exit VI eCompose. If VI eCompose services are running, before you begin any installation, close and exit the program.
Important License Information

If you are upgrading from a prior major release, for example, versions 15.0, 15.0.1.0, 15.0.2.0, or 15.0.3.0, to enable the product, obtain a version 16.0 license file.

- For customers: Use the original SWAP key supplied with your original order or purchase. At the License Menu, enter the SWAP key.
- For internal updates: Refer to the information supplied in the ISA or MAPS systems.

Note: When you are updating Xerox® VIPP® Manage software on a Xerox® FreeFlow Print Server (FFPS) device, no license update is required if the previous version of the software license was activated.
Platform Support

All FreeFlow VI Suite products run on the following 32-bit or 64-bit operating systems:

<table>
<thead>
<tr>
<th>Windows 32 bit and 64 bit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10, version 20H2.</td>
<td>Ensure that Windows 10 is maintained at the latest supported software level.</td>
</tr>
<tr>
<td>Windows Server 2012</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2016</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2019</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>macOS (Intel Processor) for VI Design Express only</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Big Sur</td>
<td>11.2–11.4 or later</td>
</tr>
<tr>
<td>Catalina</td>
<td>10.15.4–10.15.7 or later</td>
</tr>
<tr>
<td>Mojave</td>
<td>10.14</td>
</tr>
<tr>
<td>High Sierra</td>
<td>10.13</td>
</tr>
</tbody>
</table>


Note: The following software is not supported: Foundation, Core, Home, Mobile, the Internet of Things, Starter, S, Team, and Essential editions of all Microsoft Operating Systems.

For FreeFlow VI Design Express for Mac and Windows operating system support, refer to the Adobe InDesign or Adobe Create Suite documentation for Adobe InDesign system requirements.

Note: macOS Sierra 10.12.x is no longer supported.
VM Environments Support

All products, except the VI Compose product, can operate in a VM environment. No support is offered for the configuration or management of the VM system. Where applicable, for license activation, each VM system requires a unique NIC or Mac address.
Adobe Acrobat and Acrobat Reader

For important information about versions of Adobe Acrobat and Adobe Acrobat Reader, access the FreeFlow VI eCompose information, then refer to the Adobe Acrobat section.

It is important to review the Adobe Acrobat section for information about APPE, PDF, and VT requirements, and the required settings for Adobe Acrobat and Adobe Acrobat Reader.
Purpose and Use of this Document

If you are upgrading from a prior release of the FreeFlow VI Suite software, to become familiar with new or enhanced content, read this document.

Refer to the FreeFlow VI Suite release documentation on the www.xerox.com website.

1. In a Web browser, type www.xerox.com.
2. Select Customer Support > All Support and Drivers.

Note: You can find FreeFlow VI Design Express documentation in the Installer download zip file that has the .dmg extension. For the latest information, it is recommended that you read the Readme.txt file that is installed with each product.
Upgrade Recommendation

It is recommended that whenever you upgrade one component of the FreeFlow VI Suite, you upgrade all other VI Suite components. Keeping all components up to date helps to avoid VI Suite product mismatches that can result in VIPP® jobs failing with errors such as Command Not Found.

When using FreeFlow VI Design Express and FreeFlow VI Design Pro, it is critical that you upgrade any VI component that renders the VIPP® application. The components include VI Compose on the printer, and VI eCompose, which generates PDF files from VIPP® applications.

To locate the latest versions of the FreeFlow VI Suite components on the www.xerox.com website:
1. In a Web browser, type www.xerox.com.
2. Select Customer Support > All Support and Drivers.

Note: The version of Xerox® VIPP® Manage software and the version of FFPS server are not dependent upon each other. An FFPS server is pre-installed with a demonstration version of Xerox® VIPP® Manage software limited to 200 pages per job. It is recommended that you upgrade the version of Xerox® VIPP® Manage software on the FFPS server with the latest available Xerox® VIPP® Manage release. The FFPS Update Manager is one way to update the version of Xerox® VIPP® Manage software on FFPS servers.

When the VI Suite of applications is running in trial mode, the number of pages per job is limited to 200 pages. When printing VI jobs on office printers under trial mode, the limit is 10 pages. For production printers, the trial mode limit is 200 pages.

When you run the VI Suite of applications in trial mode, this table describes the trial period for each application.

<table>
<thead>
<tr>
<th>Application</th>
<th>Trial period after initial installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xerox® FreeFlow® VI Design Pro</td>
<td>60 days</td>
</tr>
<tr>
<td>Xerox® FreeFlow® VI Explorer</td>
<td>0 days</td>
</tr>
<tr>
<td>Xerox® FreeFlow® VI Design Express</td>
<td>30 days</td>
</tr>
<tr>
<td>Xerox® FreeFlow® VI eCompose</td>
<td>60 days</td>
</tr>
</tbody>
</table>
Xerox Specialty Inks

Xerox Specialty Inks (XSI) are an option on Xerox DC1000/800 and iGen5 devices, supported by FFPS, and EFI digital front end devices. Xerox Specialty Inks include:

- Clear
- Gold
- Silver

Note: Prior to the version 14.0 software release, the Xerox Specialty Inks feature was known as Clear Dry Ink, and the only color option was Clear. With the addition of the Gold and Silver options, the feature is renamed Xerox Specialty Inks.
Xerox® VIPP® Manage 16.0.3.0

This chapter contains:

- New Features in Xerox® VIPP® Manage ........................................................................................................ 14
New Features in Xerox® VIPP® Manage

This section lists all new features introduced since the release of Xerox® VIPP® Manage 16.0.3.0. New features and enhancements include the following:

- When you use the **Load Files** command, to add the files, drag the files to the Add Files dialog.
- Online Help is now available. When you click **Help**, the contents appear in a browser.
Xerox® FreeFlow® VI Design Express
16.0.3.3

This chapter contains:

- New Features in Xerox® FreeFlow® VI Design Express................................................................. 16
- Configuring Xerox® FreeFlow® VI Design Express to Submit Jobs to Xerox® FreeFlow® Core...... 17
- Configuring Xerox® FreeFlow® VI Design Express to Submit Jobs to Xerox® FreeFlow® VI
eCompose................................................................. 18
New Features in Xerox® FreeFlow® VI Design Express

This section lists all new features introduced since the release of Xerox® FreeFlow® VI Design Express 16.0.3.0. New features and enhancements include the following:

**Version 16.0.3.3**

- Capability to submit VIPP® jobs to Xerox Print Production Workflow solutions such as Xerox® FreeFlow® Core and Xerox® FreeFlow® VI eCompose. Enables VIPP® jobs created using Xerox® FreeFlow® VI Design Express to utilize processing capabilities provided by Xerox® FreeFlow Core and Xerox® FreeFlow VI eCompose easily. Jobs from Xerox® FreeFlow VI Design Express are submitted to a FreeFlow Core hot folder or a FreeFlow VI eCompose watched folder. Refer to Configuring Xerox® FreeFlow® VI Design Express to Submit Jobs to Xerox® FreeFlow® Core and Configuring Xerox® FreeFlow® VI Design Express to Submit Jobs to Xerox® FreeFlow® VI eCompose.

- Support for the latest macOS versions (Big Sur 11.4, Catalina 10.15.7, Mojave 10.14.6)

**Version 16.0.3.1**

- Support for Adobe InDesign 2021 version 16.1 or later. Support for Adobe InDesign 2019 is removed.

- Support for macOS version 11.2, Big Sur, except Mac systems with the Apple M1 chipset.
Configuring Xerox® FreeFlow® VI Design Express to Submit Jobs to Xerox® FreeFlow® Core

To submit a job for processing from Xerox® FreeFlow VI Design Express to Xerox® FreeFlow Core, submit the job to a FreeFlow Core hot folder.

Before you can submit a job to a FreeFlow Core hot folder, you need the following:

1. The UNC file path to the hot folder. Usually, the FreeFlow Core administrator creates the hot folder and provides the path to you.
2. A mapped network drive to the location of the hot folder. Ensure that you have file access permission to save files to the hot folder. If you are using Xerox® FreeFlow VI Design Express on Windows, use the Map Network Drive … option found in Windows File Explorer. If you are using Xerox® FreeFlow VI Design Express on macOS, launch Finder, then use the Connect to Server option.

Submitting a job from Xerox® FreeFlow® VI Design Express to Xerox® FreeFlow® Core from Adobe InDesign

To submit a job from Xerox® FreeFlow VI Design Express to Xerox® FreeFlow Core from Adobe InDesign, do the following:

1. To invoke the Export command, select File > Export.
   An Export dialog appears.
2. Select the mapped network drive, then open the hot folder.
3. From the Save As type menu, select Send to Xerox FreeFlow Core.
4. Click Save.
   A Create VI Project Container dialog appears.
5. In the Create VI Project Container dialog, enter the required settings. Ensure that all required files are included in the container.
6. To send the job to Xerox FreeFlow Core, click OK.
Configuring Xerox® FreeFlow® VI Design Express to Submit Jobs to Xerox® FreeFlow® VI eCompose

To submit a job for processing from Xerox® FreeFlow VI Design Express to Xerox® FreeFlow VI eCompose, submit the job to a FreeFlow VI eCompose watched folder.

Before you can submit a job to a FreeFlow VI eCompose watched folder, you need the following:

1. The UNC file path to the watched folder. Usually, the FreeFlow VI eCompose administrator creates the watched folder and provides the path to you.

2. A mapped network drive to the location of the watched folder. Ensure that you have file access permission to save files to the watched folder. If you are using Xerox® FreeFlow VI Design Express on Windows, to create the mapped network drive, use the Map Network Drive … option found in Windows File Explorer. If you are using Xerox® FreeFlow VI Design Express on macOS, launch Finder, then to create the mapped network drive, use the Connect to Server option.

Submitting a job from Xerox® FreeFlow® VI Design Express to Xerox® FreeFlow® VI eCompose from Adobe InDesign

To submit a job from Xerox® FreeFlow VI Design Express to Xerox® FreeFlow VI eCompose from Adobe InDesign, do the following:

1. To invoke the Export command, select File > Export.
   An Export dialog appears.
2. Select the mapped network drive, then open the watched folder.
3. From the Save As type menu, select Send to Xerox FreeFlow VI eCompose.
4. Click Save.
   A Create VI Project Container dialog appears.
5. In the Create VI Project Container dialog, enter the required settings. Ensure that all required files are included in the container.
6. To send the job to Xerox FreeFlow VI eCompose, click OK.
Xerox® FreeFlow® VI eCompose
16.0.3.1

This chapter contains:

• Platform Support ........................................................................................................................................ 20
• New Features in Xerox® FreeFlow® VI eCompose ................................................................................... 21
Platform Support

Xerox® FreeFlow® VI eCompose software runs on the following 32-bit or 64-bit operating systems:

<table>
<thead>
<tr>
<th>Windows 32 bit and 64 bit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10, version 20H2.</td>
<td>Ensure that Windows 10 is maintained at the latest supported software level.</td>
</tr>
<tr>
<td>Windows Server 2012</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2016</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2019</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If Windows 10 is installed on the system, ensure that the latest update is installed. FreeFlow VI eCompose version 16.0.3.x is the last version supported on Windows Server 2012, Server 2012 R2, and 32-bit operating systems.

**Note:** If you intend to enable the optional Xerox® FreeFlow® VI eCompose Web Application, before you run the Xerox® FreeFlow® VIeCompose installer, install Microsoft .NET Framework 4.8 from the Microsoft website. Previously, Xerox® FreeFlow® VI eCompose Web Application was known as Xerox® FreeFlow® VIeCompose Web Server.

Web browsers supported are the current versions of modern browsers from Apple®, Google®, Microsoft®, and Mozilla®.

Microsoft Internet Explorer and the original Microsoft Edge are not supported. Only Microsoft Chromium Edge is supported.

Browsers older than one year are not supported. To avoid compatibility issues, always use the latest version of the browser.

Always use desktop computer browsers. Mobile device browsers can exhibit display issues.
New Features in Xerox® FreeFlow® VI eCompose

This section lists all new features introduced since the release of Xerox® FreeFlow® VI eCompose 16.0.2.0. New features and enhancements include the following:

The Xerox® FreeFlow® VI eCompose user interface was upgraded from release 16.0.2.0. The new interface for desktop utilities aligns with the Windows 10 interface. An updated installation utility installs the application.

To access the Xerox® FreeFlow® VI eCompose browser interface, enter the URL address in the browser as http://<Server IP address>/FreeFlowVIeCompose or https://<Server IP address>/FreeFlowVIeCompose.

Note: FreeFlow VI eCompose version 16.0.3.x uses Windows Internet Information Services (IIS) to enable using a Web browser optionally to submit VIPP® jobs and perform administrative functions on the server. During installation, you are asked if you want to enable this feature. To start and stop the Web application, use Windows Internet Information Services manager.

Note: If you upgrade FreeFlow VI eCompose from a version that is earlier than 16.0.2.x, perform the following: After you install version 16.0.3.x, verify that the saved configurations are present using this version. If you did not install the upgrade directly over an older version in the same location, uninstall the older version manually. If you installed the upgrade over a previous version in the same location, do not uninstall the previous version, because it leaves the version 16.0.3.x installation in an unusable state.

Note: For the best user experience when you use the Web browser, maximize the browser window.

Note: For security reasons, you can install FreeFlow VI eCompose to a location other than the root of the installation drive. The default VIeC installation location is C:\Program Files (x86)\Xerox\VIPP\xvtp. The default xgfC location is C:\Program Files (x86)\Xerox\VIPP\xgfC.

The full paths of user jobs or files and system built-in macros can contain spaces, which can cause problems with parsing. For example, the following Dispatch rule CommandTemplate definition, CommandTemplate=(C:\my.bat $(PDF_FILE_PATH)), does not work when the expanded PDF_FILE_PATH contains a space, because it is read as two parameters, instead of one. To ensure correct parsing of user scripts of batch files and system built-in macros, use double quotes, for example CommandTemplate=(C:\my.bat "$ (PDF_FILE_PATH )"). For backwards compatibility, it is still possible to install Xerox® FreeFlow® VI eCompose to the root of a drive, for example, C:\xvtp. However, Xerox® FreeFlow® VI eCompose no longer installs to the root of a drive by default.
Resolved Issues

Version 16.0.3.3

Xerox® FreeFlow® VI Design Express

Fixed the issue where Arabic characters were printing incorrectly.

Version 16.0.3.1

Xerox® FreeFlow® VI Design Express

- Fixed the issue of failed installation of VI Design Express 16.0.3.0 on macOS Catalina 10.15.7 due to third-party software notarization issues.
- Fixed the issue where the installation of VI Design Express for both Adobe InDesign versions was not possible in one installation. If you need to install the Xerox FreeFlow VI Design Express software for both Adobe InDesign 2020 and 2021, during installation, enable the check boxes for both versions.

Version 16.0.3.0

Xerox® FreeFlow® VI Design Express

- Fixed issue where Rotate View using Adobe InDesign disrupts all VI fields.
- Fixed issue where Rotation affects Specialty Imaging effects on the Adobe InDesign document.
- Fixed issue where the Correlation Key pattern does not work correctly when using Adobe InDesign Rotate View applied to the document.
- Fixed issue when Void Pantograph is applied on top of text, image, graphics when applied directly.

Xerox® FreeFlow® VI eCompose

Fixed issue where the error "Unable to produce PDF file" occurs intermittently when jobs are processed.

Xerox® VIPP® Manage

Fixed issue where VIPP® Manage does not install a printer license.
Resolved Issues
Known Issues and Limitations

This chapter contains:

- Xerox® FreeFlow® VI Design Express ................................................................. 26
- Xerox® FreeFlow® VI Design Pro ....................................................................... 28
- Xerox® FreeFlow® VI Explorer .......................................................................... 29
- Xerox® FreeFlow® VI eCompose ....................................................................... 30
- Xerox® FreeFlow® VI Compose ........................................................................ 32
Xerox® FreeFlow® VI Design Express

If you are upgrading from a version earlier than 16.0.2.0, before you install Xerox® FreeFlow® VI Design Express version 16.0.3.x, ensure that you uninstall the current version of Xerox® FreeFlow® VI Design Express.

Installing Xerox® FreeFlow® VI Design Express on Mac

To install Xerox® FreeFlow® VI Design Express on a Mac, perform the following:

1. Open the VDE_Install_16.0.3.x.dmg file.
2. Copy the installation file, VDEInstaller.app to the desktop.

   🔄 Important: For macOS Catalina installations, if you do not copy the VDEInstaller.app file to the desktop, and you run the installer directly from the .dmg file path, the installation can fail without notification. For macOS Big Sur installations, if you do not copy the VDEInstaller.app file to the desktop, and you run the installer directly from the .dmg file path, a java cannot be opened because the developer cannot be verified, select cancel to terminate message appears.

3. To start the installation, from the desktop, open the VDEInstaller.app installation file.

   🖼 Note: If a dialog box appears with the message VDEInstaller is an app downloaded from internet. Are you sure you want to open it?, to proceed, select Open.

   If you are running the installer as a non-administrator user, to proceed, when prompted, enter the administrator user name and password.

   If a dialog box appears with the message iCloud Drive may not work properly, to proceed, select OK.

Upgrade VI Compose on the Printer

If you are using Xerox® FreeFlow® VI Design Express version 16.0.3.1, ensure that you upgrade VI Compose to version 16.0.3.1 on the printer.

✍ Note: Before you choose automatic Adobe InDesign or Creative Cloud updates, verify that your version of VDE runs on the later version of the Adobe software. Ensure that you disable this automatic update process.

Uninstalling Xerox® FreeFlow® VI Design Express on Mac

To uninstall Xerox® FreeFlow® VI Design Express on a Mac, perform the following:

1. Open Launchpad.
2. Select Change Xerox FreeFlow VI Design Express Installation.
3. Enter Administrator credentials, then select Uninstall.

If the Xerox® FreeFlow® VI Design Express is installed for both Adobe InDesign 2020 and 2021, uninstalling removes the Xerox® FreeFlow® VI Design Express plug-in from both Adobe InDesign versions.

Compatibility with macOS Version 11

Xerox® FreeFlow® VI Design Express is not supported on systems that run macOS version 11, Big Sur, with the Apple M1 chipset.

Specifying Media and Finishing Options for a Job Sent to a Printer

When a VIPP job is created from the Export option, a VI Project Container is created. If a container that specifies media and finishing options is sent to the printer, sometimes, the options cannot be honored, depending on the printer controller used. Xerox printers that run FreeFlow Print Server version 9 or later for Solaris and version 2 or later for Windows support media and finishing options.

If FreeFlow Print Server (FFPS) processes the job, the print server, along with the printer, determines which media and finishing options are applied to the job.

Prefixed CSV File Does Not Load Properly for macOS Only

When a .csv file that contains prefixed data is loaded into a VI Design Express file, the contents do not appear in the form and do not appear when the file is exported as a VI Design Express PDF file.

The field PrefixedFieldDescriptorTag shown in the file /Users/<username>/Library/Application Support/Xerox/VIPP/VPP/VPPconfig.ini, where <username> is the logged in username, appears as PrefixedFieldDescriptorTag=FD.

To resolve the problem, perform the following steps:

Note: Only the logged-in user can perform the following steps.

1. If the Adobe InDesign application is open, exit the application.
2. Go to /Users/<username>/Library, where <username> is the name of the logged in user. The directory Library in this path is a hidden directory within /Users/<username>/. To make a hidden directory visible, press shift, command, and period (.) simultaneously on the keyboard.
3. Go to /Users/<username>/Library/Application Support/Xerox/VIPP/VPP/VPPconfig.ini and look for the VPPconfig.ini file. If the file is found, proceed to Step 4, otherwise go to Step 7.
4. Edit the file VPPconfig.ini.
5. Modify the line PrefixedFieldDescriptorTag=FD to PrefixedFieldDescriptorTag=$$FD$$.
6. Click Save, then to close the file click Close.
7. In path /Users/<username>/, hide the directory Library. To hide a directory, press shift, command, and period (.) simultaneously on the keyboard.
Xerox® FreeFlow® VI Design Pro

Uninstalling Xerox® FreeFlow® VI Design Pro

Un-install VI Design Pro does not always appear in the Xerox FreeFlow VI Design Pro program menu. To uninstall, select Settings > Apps Wizard.
Xerox® FreeFlow® VI Explorer

Uninstalling Xerox® FreeFlow® VI Explorer

Uninstall VI Explorer does not always appear in the Xerox FreeFlow VI Explorer program menu. To uninstall, select Settings > Apps Wizard.
Enabling FreeFlow VI eCompose Web Application

If you want to enable the optional FreeFlow VI eCompose Web application, ensure that the Microsoft Internet Information Service manager (IIS) is installed. For the systems with Windows Server 2012, 2012R2, and 2016, to enable IIS, run the batch file, `Install_IIS.bat`, as Administrator, in the Tools directory of the installation package. Before you run the FreeFlow VI eCompose installer, ensure that you execute the IIS batch file.

Enabling Optional Features after the Initial Installation

To enable the optional FreeFlow VI eCompose features, run the installer, and select the features that you want to enable, such as Web Application or LPR Job Submission.

Important Cluster Configuration Information

When you configure Xerox® FreeFlow® VI eCompose in a cluster configuration, to grant access to remote resources for the default_user, do the following. Remote resources include access to remote files using mapped network drives.

- If the remote resources are all in the same domain and the logged-in user has read and write access to that location, the application has access to those locations by default.
- If the remote resources are in different networks or require different credentials, when you map the drive in Windows, use the enable the remember credentials option to store the credentials, then perform the following steps:
  1. Open the IIS Management Console (INETMGR.MSC).
     Ensure that you perform this procedure in Client and Server systems where IIS is installed.
  2. Open the Application Pools node underneath the machine node. Select the WebAppPool application pool that you want to change. By default, the application runs automatically for generated application pool identity.
  3. Right-click the WebAppPool application pool, then select Advanced Settings.
  4. Select the Identity List item, then click the ellipsis button.
  5. Select the Custom Account radio button, then click Set. Enter your administrator user name and password, then click OK. If you are in a domain, enter the user name as domain/username.
  6. Click OK.

Initializing Xerox® FreeFlow® VI eCompose for the First Time

After the system restart of Xerox® FreeFlow® VI eCompose, if you connect to the Web Application for the first time, there is a delay before the login dialog appears.
Upgrading from a Previous Version

When you upgrade from a previous version, the new default installation directory is \Program Files (x86)\Xerox\VIPP\xvtp and the default xgfc location is \Program Files (x86)\Xerox\VIPP\xgfc. It is possible to modify these default directories. If you change the directory locations to the same location as an existing previous installation, do not uninstall the previous version. If you use the same location as a previous installation, this leaves the 16.0.3.1 system in an unusable state. After you upgrade from systems prior to 16.0.0.0, you can use the sha2passwd utility to reset the password of a user. After you upgrade to 16.0.3.1, you can use the utility only once for a registered user.

Password Change Utility after an Upgrade to 16.0.3.1

To reset a password in VIeCompose version 16.0.3.x, perform the following steps:

1. Open the command prompt.
2. Change the directory to X:\Program Files (x86)\Xerox\VIPP\xvtp\bin, where X is the disk partition where the Xerox® FreeFlow® VI eCompose software is installed.
3. Enter the command using the following syntax: ChangePassword.exe <username><password> <port>, then press Enter.
   The following definitions apply:
   - username: The user name for which the password needs to be changed.
   - password: The new password for the user.
   - port: If the default port has changed, specify the port number.
   If the port has not changed, do not include the port argument in the command.

   Example:
   ChangePassword.exe test test@123
   ChangePassword.exe test test@123 9000

Help System for the Xerox® FreeFlow® VI eCompose Web Interface

When you select the Help (?) icon in the Xerox® FreeFlow® VI eCompose server Web interface, the User Guide opens as a PDF file.
Known Issues and Limitations

**Xerox® FreeFlow® VI Compose**

If you are using an EFI Fiery print server, before you proceed with VIPP® printing, ensure that all updates or patches for your EFI Fiery print server product are applied.

If updates or patches for your EFI Fiery print server product are not applied, Xerox® FreeFlow® VI Specialty Imaging fonts and Specialty Imaging jobs do not load or are not recognized.

Patches are available through your EFI Fiery device center available through your EFI Fiery Command Workstation (CWS).
Important Information About PDF

This chapter contains:

- Adobe PDF Print Engine (APPE) ................................................................. 34
- PDF Using VI Suite Tool Set ................................................................. 35
Important Information About PDF

Adobe PDF Print Engine (APPE)

Media and finishing control is available with PDF output when generated by FreeFlow VI eCompose which requires option to be selected and printing to the FFPS OR when printing VIPP® directly to the FFPS using the APPE path.

To print to the FFPS, ensure that you set the FFPS queue to APPE and the format to PDF.

Ensure that you have the latest FFPS software installed on the target print device, version 93.D4.x.x or later.
PDF Using VI Suite Tool Set

You can convert a VIPP® job to PDF using one of three methods.

1. VI eCompose is the FreeFlow VI Suite production-level VIPP®-to-PDF solution. The VI eCompose software runs on a Windows server. Four input clients are provided, including LPR, Watched Folder, Job Submission Client, and the Web submission client. The VI eCompose software, based on the content of the VIPP® application, generates a Master PDF. It can generate child PDF files also and move those PDF files to the next step in your workflow using the VI eCompose Dispatch module. For more information on FreeFlow VI eCompose, refer to the FreeFlow VI eCompose User Guide or go to www.xerox.com.

2. VI Design Pro, the interactive design environment for the generation of code-based VIPP® applications, has an Export job as PDF option from the file menu. You can use this option to generate a Master PDF file. For more information on FreeFlow VI Design Pro, refer to the FreeFlow VI Design Pro User Guide or www.xerox.com.

3. VI Design Express is the Adobe InDesign plug-in that runs on a Windows PC or a Mac OS system. This plug-in allows for rapid development of delimited-based VIPP® applications. FreeFlow VI Design Express supports an option to generate PDF output using the VI Design Express PDF option from the InDesign Export menu.

Adobe Acrobat and Adobe Reader Information

If you are using PDF Objects as VIPP® resources in your VIPP® application and you need to view the PDF file output from VI eCompose using Adobe Acrobat or Adobe Reader, ensure that you are using Adobe Acrobat or Adobe Reader, version 10.1.4 or later.

Configuring Adobe Acrobat and Adobe Reader Privileged Folder Settings

To view PDF files that contain VIPP® PDF resources, ensure that you open the PDF file from an Adobe Acrobat or Adobe Reader privileged folder.

To create a privileged folder, edit the following Adobe Acrobat or Adobe Reader preferences:

1. From the Adobe application, select Edit > Preferences.
2. Under Categories, select Page Display.
3. At the bottom of the window, under Reference XObjects View Mode, for Show reference XObject targets, select Always.
Important Information About PDF

4. For Location of referenced files, specify the path to the directory that contains the PDF files generated by VIeC.

Note:

• It is recommended that you select the VIeC incoming folder instead of the folder containing a specific job.
• As long as all of the PDFs generated by VIeC are under the same incoming folder hierarchy, all referenced PDFs will be located and properly displayed.

5. Under Categories, select **Security (Enhanced)**.
6. Under Privileged Locations, click **Add Folder Path**, then specify the same folder as specified for Location of referenced files.

![Preferences window](image)

**Note:**

- The referenced XObjects are independent of the Enhanced Security checkbox. The state of the checkbox does not govern viewing of referenced XObjects.
- Any of the following can cause Adobe Acrobat or Adobe Reader to display **Missing:** followed by the name of the missing PDF resource:
  - The version of Acrobat or Reader does not support Referenced XObjects
  - The preferences were not setup correctly
  - The PDF file was opened from a non-privileged folder
FreeFlow VI Suite Printer Support

This chapter contains:

- Printer Support
Printer Support

The FreeFlow VI suite 16.0.3.0 release adds support for the following printers:

<table>
<thead>
<tr>
<th>Printer</th>
<th>Controller and Minimum Supported Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xerox® Versant® 180 Press</td>
<td>Xerox® EX/EXi 180 Print Server Powered by Fiery®</td>
</tr>
<tr>
<td>Xerox® Versant® 280 Press</td>
<td>Xerox® EX/EXi 280 Print Server Powered by Fiery®</td>
</tr>
<tr>
<td>Xerox® PrimeLink® C9065/C9070 Printer</td>
<td>Xerox® EX/EX-i/EX-c 9065-70 Print Server Powered by Fiery® and Xerox® Integrated Color Server</td>
</tr>
<tr>
<td>Xerox® Iridesse™ Production Press</td>
<td>Xerox® EX-P 6 Print Server Powered by Fiery®</td>
</tr>
</tbody>
</table>

**Note:** VIPP® printing is not supported on the Xerox® AltaLink® series printers.

Currently, VIPP® Specialty Imaging (SI) printing is not supported on the Xerox® Baltoro™ HF Inkjet Press or on the Xerox® Versant® 4100 Press.

Additional information about the VIPP® Specialty Imaging support for these printers can be found at [www.xerox.com](http://www.xerox.com). Select Customer Support > All Support and Drivers. For product type, select Software & Platforms, then select FreeFlow > FreeFlow Variable Information Suite. Go to the documentation area, then search for FreeFlow VI Suite Specialty Imaging Customer Report.